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Getting Started

Installation

To install the software onto your PC:
1. PlacetheActinicinstallation CD in your CD drive.
2. It should automatically run. If it does not, you will need to:
Click the 'Start' button in Windowstaskbar and go to
'Run'.
Click 'Browse' and then goto 'D:' (where D:isyour CD
drive).
3. Select 'setup.exe’ and double click.
Thiswill start thefirst of the 'Installation Wizards' that will guideyou
through the set-up process. It is possible to achieve a perfectly
satisfactory installation by accepting all the default settings suggested to
you. Click 'Next' to take you from screen to screen, click 'Back' to take

you to the previous screen and click 'Cancel’ to abort the installation
process.
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Starting Actinic

Actinicisdesigned to publish an online store onto theinternet, and then
receive and process orders from that store.

It works by taking all your product data and turning it into a set of web
pages, based on the design optionsyou have selected. It then also
manages all the functionality to control the shopping cart, search and
online security at your online store.

When you first start Actinic, you will seethefollowing screen:

Software Authorization Key. E]E|

“You can enter an autharization key now, ar evaluate the software without entering a key
Authorization

Actinic requires an authorization key. Thiz key can be found inzide the CD caze or can be
purchazed from wour vendor,

Please enter your autharization key in the farm aas-aas-sas-aaa

Exvaluation

Choose the wersion of Actinic you wish to evaluate, up to a maximum of 30 dave, You can if you
wish chooze a different version each time you start the software,

Evaluation Yersion : @

() Evaluate \web Designer VAR product range
Please choose a version v

Click Here for information on the Actinic praduct range.

Dap 2 of the 30-day evaluation period. ‘Your copy expires in 28 days.

“ou can purchase a license frlom:  Actinic Saftware Limited

If you have alicense key for Actinic, enter it in thefield provided and
click 'Authorise'.

If you are setting up a multi-user site with Business Plus, you will also
need to enter ausername of Administrator and a password of
Administrator.

If you want to evaluate Actinic then you need to select one of the
‘Evaluation Version' options at the bottom half of the window.

To evaluate Actinic Catalog, Actinic Business or Actinic
Business Plus select the 'Evaluate M erchant Product Range'
option.

To evaluate Actinic Designer select the 'Evaluate Web
Designer/ VAR Product Range' option.

Then select aproduct to evaluate and click 'Evaluate'.

You will then see the following screen:

6 -
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® Designer - Online Catalogue

Edt Settings Design Operations Marketing Web Housskeeping Window  Help

Pk O )19 - @ - | Eeusines settngs [SHste optins (B3 2 @unetreve orcers 03 Eareponts 5 B 8 8 i 17

i 5] [o Preview store &P Publishto web (o] !
8 Cortent | (4 Design | @ Orders | & New Order

: Content Tree B % Start Here

§ Etow en + v

¢y Home
#-[E] More Pages
1= ¢ Online Catalogue
= 3] Books
Graat

Great E: ions |§

) Pride and Prejudice .
) Far From The Madd] Start Editing

o Store Contents
Computers
Stationery
- [ Best sellers

Hew Products

[ (7)) Pair of Casual Shoes

®
®

O

Company Tax Payment Delivery Order
Details Rates Methods Charges  Processing -

Designin  Design in Design ~
Actinic Dreamweaver Wizard N
ACTINIC

Product Detais - Great Expectations | [8), Page Preview | Start Here

=]

<

s

For Help, press FI

The Start Here Panel

In the main part of the screen isthe 'Start Here' panel. Thisisdesigned to
take you through the most important areas of the software.

s
=

Company Tax Payment Delivery Order
Details Rates Methods Charges  Processing

Click on one of the buttons and it will open up to show more
information:

£, Payment Methods

| e 2 e 3 o ] e § Edit your settings now

If you are a new business, you probably aren't geing to be able to take credit card
numbers online and process them yourself. The banks just won't let you. Fortunately
there are companies called 'Payment Service Providers' whose sole purpose is to take
your customers’ payment online and then pass the money to you.

To set up a Payment Service Provider (or PSP) you need to go to the 'Settings’ menu
and then go to ‘Business Settings”. Once ‘Business Settings’ has openened, change
to the ‘Payment and Security’ tab.

At the bottom of each page of the Start Here panel are some linksto some
useful chaptersin the main Actinic help.
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© help

How do | take credit cards online securely?

How do | integrate Actinic with a Payment Se
‘PayPal'?

How | can | restrict some payment methods tol
customers?

Also, whilelooking through the Start Here panels you will see somelinks
that will take you straight to that related area of Actinic.

Edit your settings now

Also, if you click on thelink that says'Change the look and feel of the
store', you will see abutton to start the 'Design Wizard'.

Design Wizard

Select the style of the design:

i Shrinks and Grows Dynamically

-l Fixed Width - Centered

The Design Wizard isaquick way to apply a basic design to your store
whereyou can set the layout and colours for thedesign. Giveit atry to
see what happens. If you don't like the basic theme it givesyou, there are
some othersto choose from in 'Design | Themes'.

Checking Out The Example Store

Down the left hand side of the program isthe 'Content Tree'. This shows
you the section, products, pages and information itemsin your store.
Click on the'+'iconsin thetreeto expand abranch of thetree.

=] Clathing
= Shoes
=8 Pair of Casual shaes
= Size

123 7
123 &
123 9
123 10
123 11
123 12

] Pair of Sandals

Click on any item in the tree to see its details appear in the 'Details' panel
to theright.

=

] [E] Product Details - Great Expectations | [&1. Page Previsw | Skark Here |

You can also click on the 'Page Preview' panel to see how theitem you
have clicked on will look in your online store.

8 -
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Other Places To Look

There are two other main tabs along the top of the Actinic screen:

| 3 Content [ Design | €8 Orders |

The 'Design’ tab iswhere you can change thelook and feel of
your store pages. Thiswon't bethereif you areusing a
‘Client' version of Actinic. There are details of thisin "The
Design Tab" on page 79.

The'Orders' tab iswhere you manage and process the orders
received at the store. More details on thisarein "Processing
An Order" on page 56.

Exercise - Personalising Your Store Design

This exercise will show you how to give the default Actinic store your
own personal stamp.

To begin with, you are going to run the Design Wizard to customise a
quick new look and feel for the store.

1

Click on the Page Preview tab at the bottom of the Content
tab. This showswhat the store looks like at the moment. You
can get thislook and feel back at any time by re-selecting the
default 'theme' (called 'Reflective’). Thisistalked about later
in "Choosing A Theme" on page 70.

Look at the Start Here panel and click on the'Design Wizard'
button:

On thefirst page, you can select whether your store design
will have afixed width, or shrink and grow with the browser
window. Make a choice and then click 'Next >' to continue.

On the next page, you can choose some colours for the
different parts of the design. Select some colours (by clicking
on the coloured boxes) and then click 'Next >' to continue.
You can alwaysre-run thiswizard to choose some different
ones.

Getting Started Guide

Getting Started - 9



73 Design Wiz

Color for Top Bar: #003366
Color for Second Bar: #336699
Color for Sidebars: #ccccff
Do you want a border around the * Yes
elements of the design?:  No
Color for Borders: #000000
[ <6acic ] cance  Wext- |

]-

OK| Cancel

On the next page you can decide whether your store has one
sidebar down theleft hand side, or asidebar down each side
of the design. Make a choice and then click 'Next >'.

In the next few screensyou can choose where Actinic will
placethingslike quick search bars, section lists and best
sellerslists. Again, you can alwaysre-run thiswizard if you
are not happy with your choices.

Eventually you will get to the final screen where there will be
an 'Apply Design and Preview' button.

Click thisbutton to see what effect all your changes have had
on the Actinic store. You will be taken to the Page Preview
panel to see your new design.

If you don't like what you see, re-run the Design Wizard or go to 'Design
| Themes'to choose aready-made look and feel for your store.

Next you are going to select anew 'Corporate Logo' imageto go at top of
every store page.

1
2.

Goto'Design| Themes.

At the bottom of thewindow, under where it says 'Corporate
Logo' click the'Browse' button and select a new image from
your PC.

Corporate Loga

|my-ﬂew-image gif |[ Browse... ]

Thismight bean image you usein letterheads, or oneyou
use on an existing website. It needsto be a'*.gif' fileor a
*jpg' file and not be too enormous (i.e. not more than about
600 pixelswide).

Onceyou've selected an image, click 'OK' to useit in Actinic.

Check the Page Preview panel to see how your new logo
looks.

10 -
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More Information - Getting Help With Actinic

Whenever you arelooking at a new areain Actinic, look out for the 'How
Do I' buttons.

& How Do 17

Click these buttonsto bring up a help file with link to lots of relevant step
by step guidesto using Actinic.

— =
E? ActinicMainHelp b]@g]
T -
Hide Frint  Options
" Contents | Indes | Search Step by Step Guides > Product Options he
# @ acincsais 4| How do I create options for a
Q Product Managemer | -
Q Imparting, Exporting p r°d uCt H
Praduct Appearance s
g % Product Elzzons Change to the 'Product Options' tab and then click the
ElHo e 'Add A New Option' button.
[2] what is an attic Creale Oplions
[2] Wwihy do | need ¢
E What iz a permiL Add a New Option...
2] How can | editc
z How dol chang | IF pout weank b offer your products in a range of different formats, colours
E Hew can | make of sizes then you can achieve this by creating ‘Attibutes’ and Choices'.
= Click this button to start creating these.
E How do | digplay
2] How can | make
[2] How do | hide v This will take you through a wizard that will ask you for
[2] How do | show 1| the choices you want to add. The wizard will also ask
(7] How do| create you whether the choices will affect the price your
E How do | chang A
(2] How do | charge customers will pay, and whether you want to menitor the
é How do | meke | stock levels of your choices.
e | v
[l b3 TF 1rmit lhmurn alraadu Araatnd camms Aankians for Hhin
£ | &

You can access the entire Actinic help file by going to the 'Help' menu
and selecting 'Help Topics'. Or you can click the @ button on the toolbar.
When viewing the help, use the 'Contents' tab of the help to browse by
topic. Alternatively, usethe 'Index’ or the 'Search' to locate key words or
phrases.

In addition, click on the question mark - @ - at the top right of the Details
panel (or any of the windows within Actinic) and then click in afield.
You will be shown alittle piece of help about the field.

—
Click this button to configure

exactly how pou are taking
payment an wour onling store

[ I P |

Getting Started Guide
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Previewing

Each separate section (and each brochure page) in the store will
eventually become a single web pagein your online store.

The Page Preview panel showsyou what the page you have selected in
the content tree will look like online. If you are finding the panel too
small, or you would like experience more of how your customerswill see
thesite, you can always do an offline preview. This allows you to check
out your storedesign in aweb browser.

There aretwo waysto preview

Preview Current Page - Opensonly the current pagein a
web browser. To do this, click the £ button on the toolbar,
goto'Web | Preview Current Page' or press[Ctrl + A] on
your keyboard.

Preview Store - Previews all the brochure pages and section
pagesin your store, showing you how it all fitstogether. To

do this, click the ©' button on thetoolbar, go to 'Web |
Preview Store' or press[Ctrl + W] on your keyboard.

Exercise - Previewing

This exercise will step you through the two different kinds of
previewing.

1. Makesureyou are on the Content tab.

2. Click on any section (or brochure page) in the store and click
the 21 button on the toolbar.

3. Thiswill display your page in your normal web browser.

( My Company Books - Windows Internet Explorer
[&c sl %) [ e

b b/

P e [@m conpany sooks [ - B @ - [rese - ek - 7

Sr©®@

ONLINE.SHOP.

* Home.

Charks Dickens' classic tle of ove, crie and destiny.

one free. Cick HERE 1 see fhe avaiable provucts.

Pride and Prejudice

Price: £4.00

3 ¥y Computer R -

4. Now go back to Actinic and click the B button on the
toolbar.

5. Navigate through the sectionsin your store (using the links
provided) to view them.

12 - Getting Started Getting Started Guide



6. Try adding something to the shopping cart. You should get a
warning message. Thisis because you cannot test store
functionality with a preview - only the look and feel.

Exercise - Previewing Other Pages

This exercise will show you how to preview pagesthat are not in your
content tree.

1. GototheDesign tab (not availablein Client versions).

2. Locatethe'Select Page Type' drop down, which isabovethe
preview panel on thistab.

\ Select Page Type |Content Page =l Click here ko see errors
Content Page s

Site Map
|: Terms And Conditions
Contack Us

Search
Search Results
Login

Signature
Add To Cart Confirmation —

Checkout Page 0
Checkout Page 1

3. Select apage other than 'Content Page'. The page you select
will appear in the preview panel.

4. You can then click the £ button to see how this page will
look in aweb browser.

If you are previewing a shopping cart or checkout page within a preview
page, it will contain some example data.

More Information - The Design Tab

The preview panel on the Design tab is different from the one on the
Content tab asit isinteractive. You can click on something in the
preview, and the HTML code for that item will appear in the 'Layout
Code' panel within thetab.

For moreinformation about using the Design tab, please see the chapter
called "The Design Tab" on page 79.

Getting Started Guide
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Products

The whole of Actinicis effectively geared around the presentation and
promotion of your products. Consequently there are many options
within Actinic that change how your productslook and work. With
Actinic you can (among other things):

Enter a stock level for aproduct.

Create an extended information window, containing a larger
image and/ or alonger description.

Set whether the product priceis shown including or excluding
tax.

Set whether adownloadable file will be available to customers
who buy a product.

Set up alist of related items that will appear underneath a
product.

and many more...
Within the content tree productslook like this: Ll

If thereisa'+' next to the product, it is because that product contains
options such as'size' or 'colour’ etc.

Try clicking on some of the example productsthat arein Actinic, and
look at the panelsin the Details panel to see the sort of thingsyou can
configure on aproduct.

Don't forget you can get information about a setting by clicking on the &
at theright of the Details panel title bar and then clicking in a setting.

Exercise - Adding a New Product
1. Right-click on the'Homeware' section in the content tree.

2. Ontheright-click menu, select 'New Product'.

+ Knitted Sweater -l
=
e @ 1 Copy ChrHC
& Em‘ Offline Page Preview Chrl+a
3 Stati  Mew Fragment Chrl+M
Best  New Section Chrl+5

Mew|  New Sub-Section  Shift+Chles | HOmew

Cut Chrl4i tnas | D
Delete Del
Find Corl+F H
Page Title:
Shanninn b

3. Makesureyou arelooking at the 'General' panel by selecting
'General' in thelist of panelsto theleft of the 'Details' panel.

4. Inthe'Short Description' field, enter 'Running Shoes'.
In the'Price’ field, enter '50.00'.

6. Inthe'Full Description' field enter 'Pair of lightweight
running shoes'.

14 -
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7. Inthe'Image field click 'Browse'. You need to bein the 'Sitel'
folder. If you are not there, browseto the'..\ Sites\ Sitel'
folder on your PC.

8. Select 'x-sneakers.jpg' from the 'Sitel’ folder.

Reference:
Short Description: | Runining Shoes
Price: Eﬂ.UEI Usze Prices Tab Cost Price: E0.00
Full Description:

Pair of lightwesght running shoes

Image: weneakers jpg [[] Hide on\Web Site
Thumbriait [¥] Can Be Oidered Orniine

Categonr  grandard -

9. Switch to the'Layout' panel and change the'Price Layout' to
'Sandard Tax Inclusive Price'. Thiswill mean that the price
for thisproduct will be displayed including tax.

10. Click the'Apply Changes' button.

Your new product will appear in the content tree and also in the preview
panel.

Exercise - Formatting Text

This exercise will show you how to change the appearance of thetext in
your product description.

1. Highlight the text 'running shoes within the 'Full
Description' field of your new product.

2. Pressthe B button on thetoolbar at the top of the details
panel.

Click 'Apply Changes'.

4. Thiswill makethetext 'running shoes appear bold in the
preview.

Feel free to experiment with the other text formatting options on the
toolbar to see what effect they have.

Exercise - Extended Information Windows

This exercise will add an extended information window to your 'running
shoes' product.

1. Switch to the 'Extended Information' panel.

2. Select 'Generate Pop Up Page'.

3. Inthe'Image field, just select 'x-sneakers.jpg’ again.
4

In the 'Text' field enter 'Thisisalonger description for the
running shoes'.

5. Under 'Display By, click 'Text Link'". In the'Link Text' field
type'MorelInfo...".

6. Click 'Apply Changes'.

Getting Started Guide
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This change has created an additional 'extended information' page that
will be opened in apop-up window when you click the 'More Info' text
on your running shoes product in the preview.

In order to seethe effect this change has made, you will need to:

7. Do apagepreview by clicking the 21 putton on the toolbar.

8. Then browseto your running shoes, which are currently in
the 'Homeware' section.

9. When you get there, click the 'More Info..." link.

 file: s - My Company Homeware - Mozilla Firefox g@g‘

Running Shoes

Thiz iz a longer description for the running
shoes

Dane

The main help fileincludes some information on how to open an
extended information page in the same browser window, and include a
cart button in the page. That way, you can use these pages as 'full detail'
pages for your products, and also allow customersto order from these
pages.

More Information - Other Product Settings

If you want to ask a general question when people buy this product, then
enter the question within the 'Other Info' field on the 'Prompts' panel.
You can also add adate-related question here such as'When would you
liketheflowersdelivered?.

Vet mane weould you like onthe gift tag?

Usethe'Product Layout' field in the'Layout' panel to try alternative
layoutsfor this product. If you want a more compact layout, try the 'No
Image No Description Laid Out In Single Line' layout. Feel freeto
experiment with the different layouts there to see the effect they have.
Changeit back to 'Use Parent' if you want to put it back to theway it
was.

Thereis more information on choosing layoutsin "Choosing Alternative
Layouts" on page 76.

It isalso possibleto import awhole load of productsin onego from a
spreadsheet with an import. Thisisdescribed in the main help in the
section called 'Importing'.

16 -
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Sections

You can use sections to organise your productsinto separate pages - a
section becomes aweb pagein the online store. You can create sections
within other sectionsto create a store hierarchy - and Actinic will
automatically create alink from one section to another.

Exercise - Adding a New Section

This exercise will add a new section to the store, and show you how to
place your new 'Running Shoes' product within it.

1. Right-click on the'Clothing' section and select 'New Section'.

{) Far From The Maddin| [[F=
& %' Copy ChrHC
Offling Page Preview CtrH-A
@ Mew Fragment ChrHM
e ! ion
e i Section Shift+Ctrl+s
=1 Horl  Mew Product ChrP
@ Cut ChrkHs
[+
u ﬁ Delete Del
©
=Ed con Fing CiF
> Srarcercompure -

Note: If you select 'New Sub-Section', it creates the section within the
current section.

2. Enter aname of 'Sportswear' and a description of 'A great
range of sports clothes'

3. Click 'Apply Changes'.

M ame: Sportswesr
e oo ]
Description:

& great 1ange of sports clatheg

[] Hide on\web Site Category:  Standard -
[[] Exclude from Frongle Data Feed
Include in Site Map

Your new section has been created in the content tree. The description
will be used in thelink to the section, which will appear on the store
front page (you can view this page by clicking on the green 'Online
Catalog' icon in the content tree).

You are now going to drag and drop your 'Running Shoes' product into
the new 'Sportswear' section.

4. Inthe content tree click on the 'Running Shoes' product and
hold the mouse button down.

5. Keeping the mouse button held down, drag the mouse
cursor into the 'Sportswear' section.

Getting Started Guide
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6. Releasethe mouse button. The running shoes product should
now bein the 'Sportswear' section.

FTT RS SreraeT

= Sportswear
@}- Running Shoes

Exercise - Optimising A Section

This section will show you how to use the 'Shopping Mode' feature -
which controls how productsin a section behave when they are added to
the shopping cart.

You will also see afew search-engine optimisation features.

1. Gotoyour 'Sportswear' section and go to the 'Page Settings'
panel.

2. Changethe'Page Name' field to 'sports-clothing.html' (all
lower case).

3. Inthe'PageTitle field enter 'Sportswear: Sports clothing,
tracksuits, running shoes'.

4. Click 'Apply Changes'.

Thesetwo changeswill help your page to be more visible to search
engines.

The next change will remove the 'Quantity’ field from the HTML page.

5. Under 'Shopping Mode' (on this panel) de-select the 'Use
Parent Settings' checkbox and select 'Quantity in Shopping
Cart'.

6. Click 'Apply Changes'.

Page Mame: sportz-clothing. html
Page Title: Sportswear: Sparts clathing. racksuits. nning shoes

Shopping Mode
[]Use Parent Settings () Quanlity on Froduct Page

Online customerswill now enter the quantity of productsthey require
oncethey have added product to the shopping cart.

18 -
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Product Options

There are many different waysto add optionsto aproduct. Here are
some examples of things you can do in Actinic:

A simplerange of colour options.

A range of colour optionswhere each colour isindividually
stock monitored.

A range of size and colour options.
An extraadd-on that costs extra.

A range of options where each choice costs a different
amount.

Optionsin the content tree look like this:

Attributes - B2l - These are characteristics of a product that
can vary such as'style’, 'length’, 'size, etc.

Choices - 123 - These areindividual optionswithin an
attribute.

Components - ﬁ® - These allow you to create more
sophisticated options such as an optional extra (that costs

money) or a range of options where each option isadifferent
price.

You can create options using the 'Product Options' panel of a product.

Exercise - Creating Simple Choices

This exercise will allow you to create arange of simple size choices for
your running shoes.

1

Click on your running shoes and select the 'Product Options'
panel.

Create Options

Add a Mew Option...

IF you want to offer pour products in & range of different formats, colours
or sizes then you can achieve this by creating 'Attributes’ and 'Choices'
Click thiz button to start creating these:

Edit Dptions

Once your options have been created, you can edit them in the content tree.
Click thiz button to show all the options that you have created faor this
product.

Click the'Add aNew Option..." button to start the'Add a
New Options wizard.

Getting Started Guide
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3.
4,

Add a New Option

(~
£

Enter a name for pour option [e.q. 'Size’ or Color'] and then enter some: e Pair of Casual Shoes
choices in the grid. This option is known as an ‘Attibute’ and looks like CE
thiz in the content tree: =

1237
123 8

MName of Dption

Chaices for

To add rows, click the '+ button in the top left hand

If you want different combinations of options to be comer of the grid

piiced differently (e.g. a customer will pay a certain
amount when they select a certain size with &
certain color] then select this box:

[] Combine this with another option

[ Mext > ] [ Cancel ] [HUWDUP

In the 'Name of Option' field, enter 'Size'.

In the'Choices for Sze' grid, click the'+' button (at the top
left) six times to create six blank rows.

E] Choices for Size

¥|¥|¥|¥|¥ ¥

Click in thefirst row and enter '7".

In therowsunder that enter '8','9', '10', '11' and '12". You can
use the'down' arrow on your keyboard to move to the next
row quickly.

When you have entered your choices, click 'Next'.

Just click 'Next>' again twice (as you are not setting prices,
stock levels or layouts) and then click 'Finish' to create your
options.

Your new optionswill be visiblein the content tree. You might need to
click the 'Expand All Current Options' button to see all the options.

@ Running Shoes
= Size

123 7

123 6

123 9

123 10

123 11

123 12

By default, choices appear asadrop down list in your store. If you
wanted to change your choicesto radio buttons, you can select an
alternative layout within the 'Layout' panel of the 'Sze' attribute.

Exercise - Choice-Dependent Pricing

This exercise will add a new option to the running shoes of 'In-soles'.
When customers purchase the shoes, they will be able to choose whether
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they want an in-sole or not, and which typethey want - with each one
being adifferent cost.

1. Gotothe'Product Options' panel of therunning goes again,
and click the'Add a New Option' button.

2. Under 'Name of Option' enter 'Type of In-Sole' and then
enter two choices - 'Basic and Super'.

Mame of Dption:
Type of In-Sale Chaices for Type of In-Sale
. L . M| Basic
If you want different combinations of options to be Fl Supel 1‘
piiced differently (e.g. a customer will pay a certain p
amount when they select a certain size with a
certain color] then select this bow:

[[] Combine this with another option

3. Click 'Next'and in the grid on the next screen, enter aprice
of '5.00' for the 'Super' option.

Type of In-Sole Price Stack
Basic | £0.00| il
Super | £5.00] [i]]

4. Click 'Next'and in the next screen, change the 'Select Layout
for Options drop down list to 'Permutation Radio Button
List'.

Select Layout for Options

Type of In-Sole Permutation Radio Button List =
[l

5. Click 'Next' and then click 'Finish' to create the new option.

Size
7w

Type of In-Sole

@) Basic (+£0.00)
O Super (+£500)

You now need to do a couple of changes to the '‘component' Actinic has
created in order to makethe 'Type of Insole' optional (i.e. the customer
can choose not to have one.

6. Look at the optionswithin the 'Running Shoes' product
within the content tree. You should have two components -
'Option’ and 'Optionl'.

= @ Running Shoes
+ @ COption
= Cpkionl
|
=& Tvpe of In-Sole
123 Basic
123 Super

7. Click on 'Optionl'.

8. Look at the details of the component, and changeto the
'General' panel if you arenot there already.

9. Changethe'Component Name' from 'Optionl' to 'Optional
In-Sole'.
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10. Select 'Is Optional’ and also select 'Include Nonein Attribute
Choice List".

LCompanent Mame:| Optional In-Sole
HTHL for Name: | Optional InSale

1 B

Quantity Used:

[[] Component &s Separate Order Line
Iz Optional [ Selected by Default

Include |Mone in Attribute Choice List

11. Changeto the 'Permutations' panel.

Type of In-Sole “alid Pricing Price Product
| Basic \ | Bveride | £0.00|tone)
» | Super ‘ |Dvarride | £5.00 | [Maone]

4 >

The main grid hereiswhereyou can edit pricesif required.

12. Click 'Apply Changes' to confirm your changes.

Optional In-Sole

Type of In-Sole
O Mone

3 Basic (+£0.00)
) Super (+£5.00)

More Information - Stock Levels

When you create options for aproduct, you have the option of entering
stock levelsfor your choices.

Cover Price Stack
Hardcover | £20.00| 20|
Softcover i £10,00] 108]

When you do this, Actinic creates a'hidden product' for each choice.

5
g"j Pride and Prejudice {Cover:Hardcover)

e

% Pride and Prejudice {Cover:Softcover}

These hidden products contain the stock for each option. They are
associated with each choice within the Permutations panel of the
component. The associated product isin the'Product' column in the grid.
Cowver Walid Froduct

FHardcaver | |Dvarride | 22000‘ F'ndeandF’reiud\ce{Covel:Harchvel}[?]|
b|80ftcover | |Dverride | 21000‘ F'ndeandF’reiud\ce{Covel:Softcuver}[ZH|

PFricing Price

< >

So when your customers select a certain choice online, they are
effectively purchasing a specific hidden product.
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Brochure Pages

Brochure pages are optional information pages you can include with
your store pages such as 'Special Offers', 'Latest News' etc.

There are two example brochure pages supplied with Actinic- 'Home'
and 'More Pages'. You will find these at the top of the content tree. In the
preview, you will see alist of the brochure pagesin the sidebar.

= ﬁHome

Welcome To Qur Site
Special Offer
+ @ More Pages

Brochure pages cannot contain products, but they can contain
'Fragments' - which areinformation items on a page. Sections can also
include fragments.

Exercise - Creating A Brochure Page

Thiswill createanew 'How To Find Us' pagein your store, and include
an example information item within it.

1. Right-click on the'Home' page at thetop of the content tree
and select 'New Brochure Page'.

2. Inthe'Name' field enter '"How To Find Us'.

3. Inthe'Button Image' field click 'Browse' and locate
'‘button_brochure_location.gif' in your 'Sitel’ folder.

4. Inthe'Button Rollover Image' field click '‘Browse' and locate
'button_brochure_location_highlight.gif' in your 'Sitel'

folder.
Mamne: How To Find Us

Button [mage: hutton,_brochure_lncation gif

Button Rallover Image: | buttan_brochure_location_highlight. gif

Meta Keywords:
tdeta Degcription:
[ Hide: on the 'web Site

Category Standard -

Theseimages are not used in the default Actinic theme, but they may be
visiblein other themes.

5. Click 'Apply Changes'.
This has created anew pagein the content tree.
You arenow ready to include afragment into the page.

1. Right-click on your new 'How To Find Us' page and select
‘New Fragment'.

2. Inthe'Fragment Title field enter 'How To Find Us'.
In the 'Text' field enter 'Hereis how to find our offices...."

4. Changeto the'Layout' panel and changethe 'Fragment
Layout' to 'Headline Fragment Layout'.
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- Fragment

Fragment Layout Headline Fragment Layout =
Use Parent (=Fragment Layout Using C55) ~
ragment Layouk Using C55

Image On Left OF Text And Title
Image And Title
Image Only

Image To The Left OF Text
Fragment Layout Image To The Right OF Text
Image On Right OF Text And Title
Layout For your Fragments Text And Titie -

Wariable name is "FragmentLayout”

5. Click 'Apply Changes'.

If you have asuitableimageto usefor e.g. amap then you can always
select it in the'Image' field in the 'General' panel.

More Information - Links

If you are creating afragment that refersto aproduct or asection in the
store, you can usethe'Links' panel to create alink to that item. Then just
include [LINK] in the 'Text' field, where you want the link to appear.
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Uploading Your Store

In order to really see your storein action, you need to upload it to a
website. Thiswill publish your websiteto theinternet, and you will be
able to usethe search, shopping cart and checkout functionality, and
placetest orders.

Exercise - Uploading a Trial Copy of Actinic

If you areusing atrial version of Actinic, which has been pre-configured
to work with a specific site, it issimpleto upload it to the internet.

1. Pressthe'Publish To Web' button (3")'3'-":'IiSh ta¥eb) on the
toolbar (or go to 'Web | Publish to Web").

2. You will be prompted to enter ausername and password.

3. Ifyou do not have ausername and password then you will
need to register for oneonline.

Click on the'To Apply For A New Account' link, and
follow instructions on the website.

Onceyou have supplied the required information and
received ausername and password, enter the username
and password into the fields provided in Actinic.

4. Theupload should then continue.

Check and Send Files

-f Checking HTHML pages...
-’ Checking catalog. .

J Checking search indices.
~ Reviewing files...

-f Sending base files...
J Purging files.

Sending catalog files...

Sending: signature. htrl

Thefirst timeyou upload, it will take quite awhile asit needsto upload
the entire site. After that, however, Actinic will only upload the files that
have changed.

Onetheupload iscompleted, click the & button on the toolbar (or go to
'Web | View Online Website') to view your store online.

More Information - Uploading Actinic To Your
Own Website

Theinstructionsin this section will work for most web sites, but they
won't work with all of them. If you find they don't work for your website
then you will need to contact your web hosting company.
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When the Actinic storeis uploaded to your web site, all the storefiles
(with afew specific exceptions) are uploaded to two folders on your
website:

'CGI' folder (often called 'cgi-bin') where all the script files
will be uploaded to in order to run the online search,
shopping cart and checkout. These files are sometimes
referred to as 'Perl files'.

An onlinestorefolder, which Actinic will create, that
contains all your store HTML files and images.

Note: The'home' brochure page can be uploaded to the directory level
abovethe online store folder by selecting the 'Use as Web Site Home
Page' box on the 'home' brochure page.

Beforeyou try uploading your store you need to know:
The URL (‘http:/ / ') address of your CGlI folder.

Wherethe CGI folder islocated on your web site (asit
appearswhen you connect viaan FTP program).

You will also need to know:

The URL and the FTP location of the folder on your website
that you would like Actinic to create the online store folder
within.

When you have these pieces of information, you can start the 'Web Ste
Configuration Wizard' by going to 'Web | Configure Web Site Details'.

Introduction E|E|

This wizard will step you through the Catalog network
configuration process.  This may take a few minutes,
bt this wizard is designed to be as simple as possible.
Catalog will make every attempt ko automate the
configuration. 1f you have ta manually establish your
Internet connection, please do so before continuing.

[[]Canhigure News Netwark Settings. T this box1s ™
unchecked, the wizard will start with your curent §
seflings, H

[] Canfirm Each Setting, If this box is unchecked,
seflings that can be automatically derived and
confirmed are hidden,

The Web Site Configuration Wizard will ask you for your username and
password to connect to your website, and will ask you to confirm the
locations, and the http addresses, of the folders mentioned above.

You can often just accept the defaults to achieve a successful upload.

When thewizard has finished, you can review the settings at any time by
going to 'Web | Network Setup'.

From now on, simply click the @ publish o Web 1t on the toolbar to
upload your store.
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For more detailed information on uploading, open the main help and go
to 'Putting Your Store Online'.
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Running an Online Business

Business Settings

'Settings | Business Settings' iswhere you can enter details about your
company and how you do business.

Business Settings

Company

Name: I | Customer Service Mumber. |

Addhess Registiation Information

i)

C My Street Ta 1 Deserption; | My YAT Fiegistiation Number

Hplis Tan 1 Number:

2 My Town Tan 2 Deseription

b T 2 Hurnper:
Ordering

B Fgst Cade | Credit Card Company Ref: [ My Merchant A/C Numbes

Country: United Kingdom &
Drder Processing

Contact
Payment and S ecurity Marme: My Contact. T

> Jab Title, My Job Title
=

Tax Phane Mumber; | My Phone Number

Eax Number: |

Emal Address: | YouName@iouCompanyEmaileo | wish Site Address: | W YouCompanyS erver.com

Shipping and Handling

Termnz and Conditiors

Address Lookup

[ ok J[ cencel J[ ey | [ HowDol? |

You can also set up how you will take payments and charge postage,
which are both discussed in later chapters.

It is essential to communicate clearly with your customers on the site
about who you are, where you are based, how long it's going to taketo
fulfil ordersetc. Thisbuildstrust in your potential customers, and makes
them feel more comfortable about placing an order with you. It also helps
set expectations of customers about delivery times etc.

Actinic's main way of communicating all thisinformation isvia an online
'Terms and Conditions' page. Thisislinked to from every page, including
the checkout, and contains all the information about who you are and
how you do business. Contact information isalso included on the online
receipt, and all emails and reports generated by Actinic.
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Exercise - Entering Company Contact Data

This exercise will show you whereto enter your company detailsinto
Actinic, and also enter information into an onlineterms and conditions
page.

1. Goto'Settings| Business Settings' or click the ) Business settings

button on the toolbar. Make sureyou are on the
'‘Company/ Contact' panel.

2. Inthe'Name' field, enter your company name.

3. Inthe'Address and 'Post Code' fields, enter your address.

Company

Mame: | Smith and Sons

Address
30 High Strest

Anytown

Post Code: [AM1 148

Cauntry: United Kingdom -

4. Inthe'Contact' areaat the bottom, enter your nameinto the
‘Name' field.

5. You can delete whatever isin the 'Job Title' field - or change
it to suit your requirements.

6. Enter aphone number in the 'Phone Number' field and an
email addressin the 'Email Address' field. You can also enter
atelephone number into the 'Customer Service Number'
field at the top.

7. Enter your website addressinto the'Web Site Address' field.
8. Click 'Apply".
Now you have entered some company details, you can enter someterms
and conditionsinformation.
9. Changeto the'Termsand Conditions' panel.

10. Inthe'Delivery Schedule' tab, change 'We deliver your order
right away' to 'Where possible, we will always ship orders
the same day they arereceived'.

Credit Card 5 ecurity Guarantes Reaching Us
About Us Making a Purchase Shipping + Handliny

where possible, we will akways ship orders the same day th
received in under <days> days.

11. Feel freeto make any other changesto thetext in the tabs.

You can now check theresultsin the preview.
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12. Goto'Web | Preview Store' or click the & button in the
toolbar. Make sureyou are previewing the whole store and
not just the current page.

13. Click the 'Terms & Conds' button (or 'Terms' or 'Info’ or
whatever it iscalled in thetheme you are using) to check out
your changes.

Exercise - Tax

In 'Business Settings' you also set up whether you want to enter your
product pricesincluding tax or excluding tax.

1. Gotothe'Company/ Contact' panel in 'Business Settings'.

2. Changethe'Tax 1 Description' field to read 'VAT Number'
(or equivalent if you charge an alternative type of tax e.g.
'Sales Tax #').

3. Inthe'Tax 1 Number' field, enter your company tax
registration number.

4. Click '‘Apply".
Now changeto the 'Tax' panel.

5. OntheTax panel, under 'Product Prices Entered’, select
‘Inclusive of Tax'.

Froduct Frices Entered
(O Exclusive of Tax (®) Inclusive of Tax

This meansthat you can enter prices for your productsincluding tax, and
Actinic will separate out the tax in the online shopping cart and in the
order.

6. Click 'OK', or if you want to go back to entering prices
without tax click ‘Cancel'.

To find out more about configuring tax, look at the chapter called 'Setting
Up Tax', within the 'Business Settings' section in the main help.

More Information - Advice On Selling

The most important aspect of selling onlineis how effectively you
communicate with your customers - both on the site asthey customers
are browsing, and also after the order has been placed. A missing postal
address for your company, or unclear information about delivery times
will lose you more ordersthan adesign element that is slightly out of
alignment. So take thetime to get your terms and conditionsright, before
getting into the more technical aspects of the Actinic store.
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Taking Payments

Actinic offers awiderange of options for you to take payment from your
customers.

You may choose to use a'payment service' to process your customer's
card details. A 'Payment Service Provider' (PSP) is a company that will
take your customer's card details online, and process them there and
then. You will then download the confirmation that tells you the
customer haspaid. Actinicisintegrated with alarge number of PSPs,
including 'Actinic Payments' - itsown payment service.

If you have an existing business, and already have the ability to process
credit card numbersyourself, then you may just need away for your
online customersto send you their card details. If you want to work in
thisway, you will need SSL - a method for sending information securely
over theinternet. If you want, you can purchase your own 'SSL
certificate' for your site, and Actinicwill work with it. You might want to
talk to your web hosting company about this. Alternatively, Actinic (and
others) offer a'Shared SSL' servicethat will allow you to take credit card
numbers securely for an annual fee without needing your own SSL
certificate.

Exercise - Adding a Payment Service

This exercise will show you how to integrate your store with an online
payment service. In this example, we will be using Actinic Payments.

1. Goto'Business Settings| Payment and Security'.
2. Click the'+' at thetop left of the main grid.

3. Inthenew row created select 'Actinic Payments Ecommerce'
from the drop-down in the 'Payment Method' column.

Payment Methods

Payment Method web Site Description
| Credit card details captured for... | Credit Card

Credit card detailz sent separat. . | Credit Card Details Sent 5

Irwvoice with order Irvoice \with Order

»
>
[I-| Actinic Paments Ecommerc: [ Card payments thiough 4
Actinic Papments CHP/AMOTO

Cheque on delivery
Cazh on delivery
Invoice and payment with deliver]

If you want to integrate with a different payment service,
select an alternative one from thelist.

4. Edit the'Web Site Description' field to change how the
option will be presented to your customers at the web site.

5. Now click 'Configure Method'.
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Payment Service Provider Configuration E|E|

Web site description: il:ard payments lhlnugiq Actiic

Provider : | Actinic Payments Ecommerce

Operation
() Fun in production mode
(3 Run in test mods

Trangaction
() Pre-authorise ransactions

() Charge transactions immediately
FSF seftings
Terminal [0

Transaction Key

Hash Key | '_:
Wiy W2 Enfarce v|
ety Address Check v
Verify Postcode Check v
WYerify 30 Secure : i =

Thisiswhereyou can enter details about your account with the payment
service. Click 'Information and Registration' if you want to apply for a
test account to try it out with.

If you don't have any settingsto enter here yet, just click 'Cancel' and
remove 'Actinic Payments' from the list of payment methods (by right-
clicking on the grid and selecting 'Delete Row").

More Information - Capturing Card Details
Yourself

If you havethe ability to process credit card numbers yourself, your bank
might allow you to receive card details from your customers at your
online store, and then process them when you download the order.

If you want to do this, you need to make surethe 'Credit card details
captured for later processing' payment method isavailablein the
'‘Payment Methods' grid.

You can then click 'Configure Method' to decide which security method
you use, and which credit cards you wish to accept.

Credit Card Capture Configuration

Capture Method

®;§tandald S5L or unencrypted g
{depending on whether 351 enabled}

() Shared 55L
() Actinic Inbuilt Enciyption lava &pplet]

Credit Cards Accepted - ) -
CWv2  CW2Di. | Statd.

I3
-
=
b

3 0 ] 3 O

> i 0 O 3l 0O

» | Switch O 3

P | Switch Wwith No lssue Number | [ O 3
[ Ok ] [ Cancel ]
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Shipping Charges

Actinic allows you to charge your customers for shipping their order to
them. There are two approachesto charging for shipping:

Useasimpleratethat is easy for customersto understand.
You could base this on the kind of products being ordered,
or the number of itemsin theorder.

Use amore sophisticated calculation system that works out
more precisely what the order will cost to ship, and passes
that cost onto the customer.

However you want to charge shipping, Actinic has arange of toolsto
meet your needs.

Exercise - Charging Shipping Based on the Type
of Product Being Shipped

This exercise will show you how you can set up basic shipping charges
just for the three clothing productsin the example store, which will be
different to the charges for the other productsin your store.

To start with, you are going to create a new 'Shipping Category' called
'‘Clothing' and then place your three clothing products within this
category.

1. Goto'Business Settings| Shipping and Handling'
2. Changeto the'Categories tab.

3. Click the'+" at thetop left of the grid to add anew row to the
grid.

4. Inthenew field enter 'Clothing'.

Shipping Categories
Shipping Category Default

»| Default ®
- | Clothir

Click 'OK" on 'Business Settings' to close it.
Now click on the'Basic T' product in your tree.

Changeto the 'Details' panel.

© N o O

Change the 'Shipping Category' for this product to 'Clothing'.

Shipping Category:. | Clathing =

Default
Clathing

[] Ship Separately

9. Click 'Apply changes'.

10. Repeat thisfor the other two productsin the section.
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You can now enter some shipping charges for the 'Clothing’ productsin
your store.

1. Go back to 'Business Settings| Shipping and Handling'.
2. Changeto the'Zone/ Class Tables' tab.

3. Inthewhitebox to theleft, right click on the 'United Kingdom'
zone and select 'Add Class| New Class...".

Zone/Clazs Configuration

Mew Zone...

Example - International Datapost
Example Class - Overnight
Example Class - 2 Day

Delete selected item Standard Charge

T —

=+ MNa
= Re  Propetties...

If you don't have 'United Kingdom' in the box, you could use any of the
countriesyou seethere.

4. Givethenew classaname of 'Test' and click 'OK".

With 'Test' selected in the white box, change the 'Basis' drop
down to 'Category'. A grid should appear in the'Zone/ Class

Tables' tab.
Basis: Category d
Order Cost
Shipping Categany Fived Charge Per Iterm Charge
Defaul | £2.00| £1.00|
Clothing i £1.0] £0, 50|

6. Inthe'Default' row, enter a'Fixed Charge' of '£2.00' and a 'Per
Item Charge' of '£1.00.

7. Inthe'Clothing' row, enter a'Fixed Charge' of '£1.00' and a 'Per
Item Charge' of '£0.50'.

8. Click 'Apply".

Your t-shirts and sweater will now incur adifferent shipping charge to
the other productsin your store.

Exercise - Calculating Shipping Based on the
Weight of the Order

This exercise will show you how to calculate shipping based on the
weight of productsin the order.
1. Within 'Business Settings | Shipping and Handling |
Zone/ Class Tables), click on the 'Test' classyou created in the last
exercise.

2. Now changethe 'Basis' drop down to 'Weight in kg'.
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3. Click the'+" at the top-left of the grid that has appeared. In the
new row, enter aweight of '0.25' and a cost of '£2.00'". This means
that orders that weigh up to 0.25 kg will be charged a cost of
£2.00.

4. Add another new row that hasaweight of '0.50' and a cost of
'£3.50'. This means that orders that weigh between 0.26 kg and
0.50 kg will be charged a cost of £3.50.

5. Add another new row that has aweight of '1.00' and a weight of

'£5.00'.
Package Cost
Lp to Weight... Cost DiviFle ErodgctWeights By
> 075 g200] Weightinkg ]
» 0.560 £3.50
> 1000 £R.00

— Excess
— O Don't Allow Excess

() Highest Walue Plus

-5 Per

You now need to handlewhat will happen with ordersthat weigh over
1.00kg.

6. Changethe'Excess setting to 'Highest Table Value'.

This meansthat anyone with an order that weighs more than 1.00 kg will
be charged no more than £5.00.

Finally you areready to enter some weightsin for your products. Thisis
donein the'Weight in kg' field at the bottom left of the product 'Details’
panel.

Exercise - Setting Up Free Shipping for Specific
Products

Itissimpleto give certain products free shipping.

1. Gotothe'Details panel of aproduct that you want to have free
shipping.
2. Select the 'Exclude from Shipping Band Calculation' checkbox.

3. Click '‘Apply changes'.
This product will now be exempted from any shipping charges.

You can also enter avaluein the'Shipping Supplement' field hereif you
want aproduct to always cost a specificamount to ship.

More Information - Shipping By Volume

Actinic supports calculating shipping charges based on the
dimensions/ volume of the order.
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You can enter a'volume' valuein the 'Volumetric Weight' field within the
'Details' panel of a product. Then you can set the calculation basis for a
particular shipping classto 'Alternative Weight' using the '‘Basis' drop-
down within the'Zone/ Class Tables drop down list. Then fill in atable
of valuesin the sameway as for weight - as described above.
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Marketing and Promotion

Best Sellers and New Products

'‘Best Seller Lists' and 'New Products Lists' arelist of products that can
appear on every page (or just on specific pages) to promote certain
productsto your customers.

Best sellerslistswork out the best selling products from the orders that
have been received, and display them as alist in the store. The best
selling itemsin your store arethe ones that most people will cometo
your siteto buy, so by displaying them prominently in your store you
will help customersfind them more quickly, which will hopefully turn
into more new orders.

New products listsare made up of the newest itemsthat have been
added to the store. It isimportant to keep displaying your new est
product lines as this keeps your store content current and up to date and
hopefully gives customers areason to keep coming back to your store.

By default in the example Actinic storethereisanew productslistin the
sidebar of every page, and also on the brochure home page.

Exercise - Adding A Best Sellers List
This exercise will add a'Best Sellers' list to your store pages.
1. Goto'Marketing| Best Sellers'.
2. Inthe'Include Sales from last' field, enter '999'.

3. Click 'Generate Now'.
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Best Sellers E|§|

Enabled
Mumber of Products in Lists B Generate Now
Period of Sales to Process
(®) Include Sales from Jast |9§l_‘3l__i Days
() Include Sales from | | ta \ !

Auto-Generate List on Upload

(&) Every | 1 J Days (O Every Upload (O Meyer

Best Sellers List

Order Product
: | Pair of Casual Sh..

Pride and Prejudice

Lock
1 ]
2|Knitted Sweater ]
3|Basic T ]
4 O
5 ]

Baox of Staples

[ aK. ] [ Apply ] [ Cancel ] [ How Do l? ]

Thiswill search through thedemo ordersthat arein Actinic and work
out the best selling items from that.

4. Changethe'Include salesfrom last' field back to '30' and
click 'OK".
5. Now click 'OK" and look at your sitein the 'Page Preview'

panel. You should see a best seller list in the sidebar of every
page, and also one on the home page.

Best Selling ltems

Pair of Casual Shoes Knitted Sweater

£60.00 £30.00
Thiz quality Comfortable,
wintage-shyle heawpneight

and durable -
this ame ater is
made from
100 %
lambamaal.

footmear is not
to be missed.
find out mare

find wut more

1 Pride and Prejudice :  Box of Staples | Startd

6. Now goto'Marketing| New Product Listing'.

7. Click 'Generate Now'. Therunning shoes should be added to
thegrid.

8. Click 'OK"and you should seetherunning shoesin the 'New
Products' list on the sidebar of each page.

New Products

Punning Shoes

£58.75

Fair of
lightuwaight
running shoes
find aut more
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Exercise - Changing Where The Lists Appear

This exercise will allow you to control where the best sellers and new
productslists appear in the store.

1. Goto'Settings| Site Options and change to the 'Layout'
panel.

2. Find the'Best Sellers List' sub-heading at the bottom of the
grid.

3. Changethe'Location For Best SellersList' setting to 'Home
Page Only'.

4. Now under 'New Products List' change the 'Location for
New Products List' setting to 'Sidebar Only".

= Best Sellers List
Best Seller Item Layvout (For Section Pages) Use Parent (=Full Best Seller Lavout Using C55)
Eiest Seller List Layout {For Sidebars) Sidebar Best Sellers List
Best Sellers List Layout (For Section Pages) Full Best Sellers List
Location For Best Sellers List Home Page Only
= Mew Products List
Location For Mew Products List Sidebar Only =
Mew Products Ikem Layout {For Section Pages) Use Parent (=Both Sidebar and Home Page)
Mew Products List Layout (For Section Pages) Both Sidebar and Home Page
Mew Products List Layout For Sidebars) Home Page Onl -

5. Click 'OK".

You should now have best sellerslist appearing on the brochure home
page and the new products listing appearing in the sidebar of every

page.

Note: If you try and change the 'New Products List Layout (For Sidebars)'
or the 'Best Sellers List Layout (For Sidebars)' it doesn't change anything
in the default theme, but it will have an effect in other themes.

More Information - Customising the Lists

If you go tothegrid at the bottom of 'Marketing | Best Sellers' or
'Marketing | New Products Listing' you can click on any item in the list
and usethedrop-down list to manually changeit to a different item.

You can also click the 'Lock' checkbox to fix that product in thelist and
let all the other products auto-generate around it.

Best Sellers List

,_
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»

Order Praduct

Basic T

Premium T

Knitted Sweater
Mot Used
Mot Used

Ojo|o|ojx

If thereisacertain product that you don't want to appear in the
marketing lists, de-select the appropriate checkbox within the 'Marketing
panel of the product.

Include in Automatic Lists

[ Best Sellers Mew Products

Getting Started Guide Marketing and Promotion - 41



Related Item Lists and Also Bought Lists

Aswell asthe best seller lists and the new productslists, it isalso
possibleto place some marketing lists underneath the productsin the
store. There aretwo types of these lists:

Related Product lists - whereyou can set up alist products
that areall related in some way to a certain product.

Also Bought lists - (Actinic Business/ Designer only) - these
are automatically worked out by Actinic. Actinic can takea
product in your store, then look at all the ordersthat include
that product, and then look at what elsethe customers order.
These then become a 'customers who bought this also
bought..." list underneath the product.

Aswell as appearing underneath productsin the store, these lists can
also appear on the shopping cart pagein the online store. That way,
customers can see some productsthat arerelated to the products that
they already havein their shopping cart.

Exercise - Creating a Related Products List

This exercise will include arelated productslist for the 'Basic T' product
in your store.

1. Goto'Marketing| Related Products'.

2. Select 'Enabled'.
3. Click 'OK".
4. Now gotothe'Basic T' product (within the 'Clothing'

section).

5. Gotothe'Marketing' panel and click the'+' at thetop left of
the 'Product Related Products' list.

6. Intherow created, choose 'Premium T' from the drop-down
list.

Thisis an example of how you might use therelated productslist to
create an upsell from one product to another.

7. Now click the'+' and thistime select 'Pair of Sandals' from
the list.

Product Related Products List
Order Praduct
L

1|Premium T

8. Click 'Apply Changes' and check out your changesin the
preview.

Exercise - Also Bought Lists

Actinic Business/Designer only
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This exercise will generate 'customers who bought this also bought..." lists
into your store, and show you how to change the layout of them.

1. Goto'Marketing| Also Bought...'
2. Select 'Enabled'.

3. Changethe'lnclude Salesfrom last' field to '999' and then
select 'Generate Now'.

Also Bought List Generation

-’ Generating Product &lso Bought Lists

L

Thiswill generate alist for nearly every product in the default store.

4. Change'lnclude Sales from last' back to '30"' and click 'OK".
5. Go back to the'Marketing' panel for the '‘Basic T' product.

You should see that some products have been automatically added to the
list. These products will appear in afairly standard numbered list by
default, but there is an alternative layout option.

6. Goto'Settings| SiteOptions| Layout'.

7. Under the'Product' sub-heading, find the 'Product Also
Bought Item Layout' setting.

FIICE TayToT TISE FarET =N arT TEx CRCISTFE FTICES
Product Also Bought Ttem Layaout Mini Also Bought Item =
Product Layout Standard Product Also Bought Tkem
Product List Layout | so Bought Them
Product Related Products Tkem Layout Ight Ieem W‘t A .

Width OF Product List 500
c

8. Changethis setting to 'Mini Also Bought Item' and click 'OK".

This should include an image, price and description into the also bought
list for the 'Basic T'.

People who bought this item also hought:

Knitted Sweater

£30.00
Comfartable, heavweight and durable - this awe
find aut mare

Pride and Prejudice

P ",.'.iii. £4.00

S TR I ) )

ity Jane Austen's classictale of infrigue, suspense an
| !‘!

find out mare
Therelated itemslist also has an equivalent layout option.

More Information - Lists in the Shopping Cart

Onceyou enable either related item lists or also bought lists you will see
alist appearing in the online shopping cart underneath the grid of
products. These lists show therelated products and also bought products
for the product that is currently in the shopping cart. If thereis more than
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oneproduct in the shopping cart, then Actinic will merge all therelated
products and also bought productsinto asinglelist.
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Mailing Lists

Actinic gives you the ability to easily extract your customers' contact
details out of Actinic. Thisinformation can then beimported into
emailing programs like Microsoft Outlook or GroupMail in order for you
to mail your customers with promotional material.

Thisfeature can befound at 'Marketing | Mailing Lists'.

All versions of Actinic allow you to filter your customers' contact details
based on when they placed orders, and what the status of the order is.
Actinic Business/ Designer customers can go further and filter the list
based on what products were ordered, where the customer islocated and
how largethe order was. With Actinic Business/ Designer, you can also
print mailing list information onto labels and envelopes.

Exercise - Creating a Mailing List

This exercise will show you how to build amailing list based on the three
exampleordersthat arein the'Orders tab in Actinic.

1. Goto'Marketing| Mailing Lists'.

2. Under 'Order Satus', de-select 'Completed' and select 'Any".
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3. Inthe'From'field, make surethe dateis somewhere before
May 25th 2006 - asthat iswhen thethree example orders
were created.

4. Makesurethat 'Order Payment Status' is set to 'Any".
5. Click the'Preview List' button.

This showsyou the three sets of customer datathat are ready to export.

6. Inthe'Format'field, select 'Standard Format'.
7. Click the'..." button next to the 'Filename' field.

8. Browseto your computer's desktop and enter 'export.csv'in
the'File name' field. Click 'Save'.

9. Back on the'Mailing Lists' window, click the 'Export List'
button.

Actinic automatically removes any duplicate records, based on the email
address supplied with the order.

Exercise - Advanced Filtering
Actinic Business/Designer only

This exercise will show you how to filter the mailing list based on
whether customers have ordered the 'Knitted Sweater'.

1. Goto'Marketing| Mailing Lists' and go to the 'Select
Products' tab.

2. Click 'Get Products'.

3. Inthetree, click the'+' next to 'Online Catalogue'. Then click
the '+' next to 'Clothing'.

4, Select the 'Knitted Swveater' checkbox.

5. Now go back to the'Main' tab and make surethat the 'From
field is set to sometime before May 25th 2006.

6. Finally, pressthe'Preview list' button to updatethelist. It
should only contain 'Jack Smith'.

46 - Marketing and Promotion Getting Started Guide



Filtering can also be done on location (in the 'Location Lookup' tab) and
order size (in the 'Order Details' tab).
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Order Level Discounts

Order-level discounts are availablein all versions of Actinic, including
Actinic Catalog. They allow you to create discountsin the storethat are
triggered by how much the customer has spent online. For example, you
can use thisto create a discount that says "10% off all orders" or "£10 off
all ordersover £75".

Exercise - Creating a Discount Based on Order

Value

This exercise will create a'weekend sale' where all orders have 10% off
within a set time period.

1

Go tothe'Marketing' menu and then select 'Discounts and
Surcharges Settings...".

Gotothe'Order Level' tab (if you arenot on it already).

Click the 'New' button at theright and enter aname for your
discount of 'Weekend Sale'.

Changethe 'Based On' field to 'Cart Value Including Default
Tax'.
Change 'Type' to 'Percentage’.

In the 'Triggers' grid click the '+' at the top left and enter a
value of '10' in the 'Percentage’ field.

Click 'Apply".

Thiswill put adiscount on your storeright away, so before you upload
and test this, you are going to restrict the discount to only being for this
coming weekend.
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8. Changeto the'Restrictions' tab (within the'Order Level' tab).
9. Inthe'From'field select the upcoming Saturday.

10. Inthe'To' field select the upcoming Sunday.

11. Click 'OK"

There will now be a 10% discount on all orders placed at your store for
the coming weekend.

Note: you may want to remove this discount if you are about to put your
storelivel

More Information - Restricting Discounts

In the exercise above you restricted a discount to a date range. You don't
have to set both the 'For' and 'To' fields - you can set one or the other if
you want to start adiscount now and end it on a certain date, or start a
discount on a certain date and let it run indefinitely.

Additionally, if you are using Actinic Business/ Designer, you will seein
the 'Restrictions' tab thereis also a 'Restricted to Customer Group' grid. If
you wanted a discount only for your retail customers or for specific
customer groupsyou can use the grid to set it up.

Customer groups arediscussed in alater chapter.
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Advanced Discounting

Actinic Business/Designer Only

Aswell as creating discounts based on order value, Actinic Business and
Actinic Designer allow you to create discounts that are based on the
itemsthat are in the shopping cart. This allowsyou to set up discounts
such as '3 for the price of 2' and 'Buy any three booksfor 5.00'.

Thereisan example '3 for the price of 2' discount already set up in the
'‘Cart Contents' tab in 'Marketing | Discounts and Surcharges Settings'.

Also, you have the option to activate any of the discounts by customers
entering a specific coupon code online.

Exercise - Buy Both T-Shirts for 10.00

This exercise will create a new 'Fixed Price' discount for the two t-shirt
productsthat arein the default database. The first thing you need to do is
tell Actinic that thetwo t-shirts arerelated to each other. Thisis done by
putting them both into a'Product Group'.

1. Gotothe'Marketing' menu and select 'Product Groups'.
2. Click 'New' and enter aname of 'T-Shirts.

3. Select the'Basic T' product from the right-hand list and use
the '<' button to moveit to the 'Members' list.

4. Dothesamefor the 'Premium T'.

5. Click the'Discounts' button and click 'OK' on the message
that appears.

You should now be on the 'Cart Contents' tab within '‘Discounts and
Surcharges Settings'.

6. Click 'New' and enter adiscount name of 'T-Shirt Offer’.
7. Change'Based On'to 'Quantity".
8. Inthe'Trigger' field, enter '2'.
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9. Change'Product Group'to 'T-Shirts'.
10. Change'Reward Type€' to 'Fixed Price'.
11. Inthe'Reward Amount' field enter '10.00'.

12. Click 'Apply".
13. Changeto the 'Presentation’ tab.

14. Enter thefollowing text: 'Buy both t-shirts together for only
10.00'.

15. Click 'OK".

The 'Buy both t-shirtstogether...' message will appear underneath the
descriptions of both t-shirt productsin the preview, and will also appear
in the shopping cart.

Exercise - Coupons

This exercise will set up adiscount that isonly triggered when customers
enter acoupon code online.

1. Gotothe'Order Level' tab within 'Marketing | Discounts
and Surcharges Settings'.

2. Highlight the 'Weekend Sale' discount you created in the last
chapter.

If you don't havethis discount set up, then highlight the '‘Order
Adjustment Example' discount (which isin the default database) and
select 'Enabled’.

Select the 'Requires Coupon Code' box.
Enter a coupon code of '12345'.

Click 'Apply".

Now changeto the 'Miscellaneous' tab.
Under 'Coupon Codes' select 'Store Pages'.
Click 'OK'

© N o o M W

This should insert a coupon entry field into the sidebar of your store
design.
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More Information - Offering Products as
Rewards

One of the'Reward Type' optionsyou havein the'Cart Contents' tab of
'Discounts and Surcharges Settings' is 'Money off extra product’ and '%
off extra product'. These allow you to offer customers free/ cheaper
product as part of apromotion.

The'extraproduct' in question isany product from a specific product
group that you have set up in Actinic. If you want just to offer a specific
single product then you will need to create a product group that just
contains that one single product.
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Day to Day Administration

Retrieving Orders

To retrieve any orders placed at the store, click the 'Retrieve Orders'
button on the toolbar ( ), or goto 'Operations| Retrieve
Orders'. Actinicwill connect to your store and seeif there are any orders
on the sitewaiting to beretrieved. It then downloadsthem and liststhe
orderswithin the 'Orders' tab. You can view the details of an order by
double-clicking on it.

Some people check for new orders throughout the day. If you are not
expecting that many ordersto be placed at your store, you can just check
your email inbox for 'New Catalog Order Received' notification emails.
This email is sent just after thefirst order is placed after the most recent
order download. You will then know thereis at least one order to
download.

Note: You must select the 'Send me an Email When | Have an Order to
Download' checkbox in '‘Business Settings| Ordering' to have this email
sent to you.

Exercise - Downloading and Viewing Orders

This exercise will show you how to download and view order details
with Actinic. You need to have placed sometest orders on thesitein
order to have anything to download.

1. Onceyou have placed one or more test orders at your Actinic
store, switch to the 'Orders' tab.

2. Click the'Retrieve Orders button ( ) on the
toolbar.

3. Your order should then belisted in thelist on the 'Orders'
tab.

Note: There arethree demonstration orders already in Actinic.
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4. Doubleclick on your new order to open it.

5. The'Customer' tab showsyou the name and address
information supplied with the order.

6. Changetothe'Line ltems' tab. This showsyou theitemsthat
have been ordered.

7. Changeto the'Progress and Payments' tab. This showsyou
the payment information entered at the store.

8. Now click the'OK" button to closethe order.

In the next chapter you will see how to process an order.

Exercise - Creating a Packing List

When you receive new orders, you can print a 'packing list' for each
order, which can be used when making up the order, and also can be
used as adelivery note on the front of the package sent. This exercise will
show you how to print packing lists.

1. Goto'Operations| Report Selection'.
2. Changeto the'Order Processing' tab.

3. Select 'Outstanding Packing Lists'.
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If you haven't placed any test orders, you might get a message box
popping up at thispoint telling you that there no outstanding reportsto
be printed. You can still see thereport, however, by right-clicking on an
order and selecting 'Reprint Standard Packing List Report'.

4, Click 'Preview'.

Thiswill lay out the order information within a packing list report.

More Information - Assurances

Ordersare encrypted to two levels on the site. Any credit card
information is encrypted with a 1024-bit encryption key - which you can
view by going to 'Housekeeping | Security'. The name and address
information isthen encrypted aswell, but with alighter level of
encryption asthat information isless critical.

Orders are stored asfiles on the website with an extension of *.ord. Once
the order isfully downloaded into Actinic, Actinic will send up a
command to theweb siteto deletethe order fileson the site. Thisonly
happensonce Actinicis surethe order has been safely received.
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Processing An Order

Thereisaset of order processing techniques built into Actinic. Some are
optional, and some arerequired - i.e. Actinic will not consider an order as
being 'complete’ until you carry them out. The required order processing

stepsare:

Thelines of the order must all be marked as 'shipped’ or
‘cancelled’. Thisis shown below.

All payments for the order must be marked as being
'received’. Thisisalso shown below. If you are using a PSP
(Payment Service Provider) the payment will be taken online
and so the paymentswill be marked asreceived before the
orders are downloaded into Actinic.

Aninvoice must be printed for the order.

Alternatively if you don't want to process orderswithin Actinic then you
can select the '‘Bypass Catalog Order Processing' option in 'Business
Settings| Order Processing'.

Thiswill mark the order lines as shipped and the payments asreceived
as soon asthe orders aredownloaded. You can then do one of the
following actions:

Print a'Data Entry' report. Thisisasingle piece of paper
containing every piece of information about an order. To
enable thisfeature, you need to select 'Enable Data Entry
Reports' in 'Business Settings| Order Processing'. To print a
data entry report, select 'Outstanding Data Entry Reports' in
the'Order Processing' tab of the 'Operations| Report
Selection' window.

Export orders. This exports order information as a set of csv
spreadsheet files for importing into another application. This
istypically donein conjunction with 'Actinic Link' - Actinic's
accounts integration package (Actinic Business/ Designer
only). To enable exports, select 'Enable Export to Files' in
'‘Business Settings| Order Processing'. To carry out an
export, go to 'Operations| Outstanding Exports'.

Exercise - Processing an Order

This exercise will show you how to use Actinic'sin-built toolsto
completeanew order. This exerciseisbased around order number

'DEM O0000000001' in the example Actinic database, but you could easily
carry out these stepswith any order.

1

2
3.
4

Changeto the'Orders' tab (if you are not there already).
Double-click on order number 'DEM O0000000001" in the list.
Changeto the'Line Items' tab.

Highlight 'Great Expectations' and click the 'Ship' button.

56 -

Day to Day Administration

Getting Started Guide



If the 'Ship' button is not available, it might be because you have selected
'‘Bypass Catalog Order Processing' in 'Business Settings | Order
Processing'.

5. Highlight 'Pair of Casual Shoes' and click the 'Ship' button.
6. Highlight 'Teapot' and click the 'Ship' button.

Obviously if you have different order contents, then ship whatever order
lines arein the tab.

7. Click the'Mail' button. Thiswill generate an 'Order Shipped'
email ready to be sent to the customer.

8. Click 'Done'.

You can view the email in the'Mail' tab of the order. And send it by
going to 'Operations| Send Emails'.

9. Changeto the'Progress and Payments' tab, and click 'OK' on
the warning message that appears (you might want to select
the 'Don't show this message again' box).

10. On the'Progress and Payments' tab you should seethe
demonstration credit card details. Click the 'View Payments'
button.

11. Click 'New Entry' and then click 'OK".
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This has made an entry in the payment history of the order saying that
the credit card payment has been received. You would normally only do
thisonceyou have put the credit card information through a credit card
terminal.

12. Click 'OK'to close the order.

13. Goto 'Operations| Report Selection' and make sureyou are
on the 'Order Processing' tab.

14. Select 'Outstanding Invoices' and click 'Print'.
15. Thiswill print the invoiceto your printer.

The order should now have disappeared from the 'Orders' tab. You will
find it by going to the 'Completed' tab (change tabs at the bottom of the
window). Theorder isnow marked as completed.

Exercise - One-Click Order Processing

Rather than doing each step of the above exercise, it is possible to pre-
configurethethingsyou want Actinic to do to each order, and then
simply 'Complete' the orders with asingleclick. Thisis described below.

1. Goto'Business Settings| Order Processing'.

2. Select 'Enable One-Click Order Completion' (if it is not
selected already).

Select 'Print Packing List'.
4. Select 'Mark Packing List Printed'.
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Click 'OK".

Now right-click on any order in the 'Pending' tab and select
'‘Complete Order'. Or highlight an order and click the
'‘Complete' button.

The order should moveto the 'Completed' tab.

More Information - Full Order Details

All thetabswithin an order are described below:

Customer - Thisiswhereyou can view and edit the
customer contact information.

Line Items - Use thistab to ship items, and cancel them. You
can also click the'Add New Item' button to add a new
product to the order.

Shipping and Handling - You would only really use thisif
you want to change the selected shipping method after
receiving the order. Change the shipping classin the'Class'
field at the bottom right, and then click 'Update Order
Shipping'. You can also manually enter a shipping charge
into the'Calculated’ field.

Taxes - View the tax charges on the order.

Totals - For reviewing any changes you have madeto the
order

Progress and Payments - Where you can view the order
status and enter/ edit payment information.

Misc. - Thisiswhere you can check any supplementary
information provided with the order such as purchase order
number, or answersto the 'General Information' questionsin
the checkout.

Mail - View the emails generated regarding thisorder. You
can also send any pending emails, and generate new ones.
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Journal - For making notes about the order.
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Monitoring Stock

Actinicincludes a'stock monitoring' featurethat helpsyou keep track of
the stock level of the productsin your store. The stock level of aproduct
isreduced when an order for that product isdownloaded into Actinic.

You can enter stock levelsfor products by going to the 'Stock’ panel of a
product and filling in the 'Estimated Stock In Hand' field. You will also
need to make sure the 'Stock Monitoring' checkbox is enabled.

You can also get an overview of the stock levels of all the productsin
your store by going to 'Operations| Stock Levels' or by clicking the

icon on the toolbar. This allowsyou to quickly add/ review stock levelsin
Actinic across anumber of products.

There are two stock warning levels for Actinic:

Warn If Below - if the stock level of aproduct falls below
thislevel, you will receive awarning when you download
orders.

Suspend If Below - if the stock level of aproduct falls below
thislevel then the add to cart button will be replaced with an
'OUT OF STOCK' message.

You can set default values for these two stock warning levelsin 'Business
Settings| Options.

By default, none of the productsin the example store are stock
monitored.
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Exercise - Stock Monitoring
Thiswill simulate what happenswhen a product goes out of stock.

1. Gotoyour 'Running Shoes product you created earlier.

If you don't havethis product, you can use any product.

2. Switch to the 'Stock' panel.
3. Setthestock level at '20'.
4. Click '‘Apply changes.

Thisproduct isnow stock monitored. If you place atest order for this
product the stock value will go down.

5. Now changethe stock level to '1' and click 'Apply Changes'.

6. You should find that the add to cart button has been replaced
with an 'Out Of Stock' message.

7. Now goto'Operations| Stock Levels'.

8. Changethe'Select Product Type' drop down to 'Ordering
Suspended' to seethe product you have just put out of stock.

You would now need to upload the store in order to see the product
marked as being out of stock online.

More Information - Stock Reports

There are afew reports available to help you monitor stock levelsin your
store. If you go to 'Operations| Report Selection' thereisa'Catalog’ tab
that features four 'Stock Level' reports. You can print theseto help you
monitor the stock levelsin your store.
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Entering New Orders

Aswell asreceiving orders from your online store, Actinic also allows
you to enter orders straight into the program. This allowsyou to also
take orders over the phone or viafax, and keep all the order information
in one place.

Exercise - Adding a New Order Into Actinic

If you are using Actinic Business (or Actinic Business Plus) then you can
enter new ordersinto Actinicusing the'New Order' tab.

To enter new ordersinto Actinicusing the'New Order' tab, you need to
do thefollowing:

1. Click the'Search' button (in the 'Product Entry' box) to select
aproduct to add to the order.

If you know the reference of the product you want to add, you can just
typeitin the 'Ref' field and click 'Show".

2. Theproduct detailswill show up in the 'Selected Product’
area. You can select options and quantities and then click
‘Update Cart'.

3. Then all you need to do is enter the name and address
information into thefields provided and select a shipping
method.

4. Onceyou've confirmed the cost of the order with the
customer (assuming you are taking thisorder over the
telephone) you can take the customers payment details and
then click the 'Confirm' button to add the order to the order
listin Actinic.

]

If you are using Actinic Catalog, you won't havethe'New Order' tab so
you will need to click the 'New Order' button on the'Orders' tab to add a
new order to Actinic.

To add anew order into Actinicusing the'New Order' wizard:

1. Gotothe'Orders tab and go to 'Operations| New Order' (or
click the 'New Order' button at the bottom of the tab).

2. Onthefirst screen select 'Shopped Before'. Thiswill save you
alot of typing later on.
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10.
11

12.
13.
14.

Click the 'Search' button and then click the 'Search' button on
the new window. Thisshould giveyou alist of all the orders
currently in Actinic.

Select an order and click 'Select'.

Click 'Next >'to moveto the next screen.
Review the contact information and then click 'Next >'.
Thisscreen iswhereyou add itemsto the order. Click 'New'.

From the 'Select Product' drop down list select 'Set of
Glasses'.

In the 'Components/ Attributes' window select the '8 Glasses'
option.

Click 'OK" and then click 'Next >'.

This screen iswhere you can select the shipping method and
enter payment information. Make sure 'Payment Method' is
set to 'Credit Card' and select 'Type' of 'Visa'.

For the 'Number' enter '1111222233334444'.
Select avalid 'Expiration Date' and click 'Next >'.

Click 'Confirm' to complete the new order.

Your new order should now be added to thelist of ordersin the
'Pending' tab.
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Exercise - Editing An Existing Order

It ispossibleto edit an order to add new items. This exercise will show
you how.

1. Double-click on an order in the 'Orders' tab.
2. Changetothe'Line ltems' tab.
3. Click the'Add New Item' button.

4. Click 'New' and add the 'Far From the Madding Crowd’
product to theorder. Click 'OK".

5. Click 'Next >' then click 'Next >' again and then click
‘Confirm' to complete the addition.

Your new book should now be visible within the'Line Items' tab.

More Information - Settings in Business Settings

If you go to the'Order Processing' panel within '‘Business Settings' you
will seethere are few settings here under the heading of 'Offline Order
Processing'.

Select 'Allow Unit Price Override' if you want to be able to change the
price of itemswhileyou create new orders.

You can also choose a different prefix for the offline order numbersin the
‘Order Number Prefix' field.
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Regular Customers

Using Actinic, you can set up customer accounts for your regular
customers. Thisallows customersto log into the store with a username
and password, and havetheir name and addressinformation preset in
the checkout.

If you are using Actinic Business/ Designer you can go further and group
your customersinto 'Customer Groups'. You can then assign discountsto
these customer groups and also hide products from certain groups of
customers.

Exercise - Creating A Customer Account
This exercise will show you how to create a basic customer account.

1. Goto'Operations| Customer Accounts or click the icon
on the toolbar.

2. Click 'New Customer'.
In the'Name' field enter 'Test Account'.

4. Click the'Copy Details From Order Contact' button. This
showsyou all the order contact information already in
Actinic.

5. Double-click on one of the namesin thelist. Thiswill
populatetherest of the fields here - and saves some typing.

6. Changetothe'Addresses tab. Thishas been pre-populated
with the order information brought in by the previous step.

7. Changeto the'Buyers tab and click 'New".

A 'Buyer' isacustomer who will actually log into this account with a
username and password.

8. Changethe'Login', 'Password' and 'Confirm' fields all to be
'a'. Thisis so you can log into the store quickly to test this.
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9. Click 'OK".

Your new account has now been created. To test this, upload the store
and click the'Login' link. Then enter ausername and password of 'a’ to
log into the account. Add something to your cart and checkout to see the
preset address information.

Exercise - Creating A Customer Group
Actinic Business/Designer Only

You will now create a'Trade' customer group, who will receive a 20%
discount when they log in.

1. Goto'Marketing| Customer Groups or click the  button
in the toolbar.

2. Click 'New' and enter aname of 'Trade'.

3. Highlight your 'Test Account' account and use the '<' button
to moveit to the left '"Associated Accounts' column.
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4. Click the'Customer Pricing' button, and click 'OK' on the
window that appears.

5. Highlight 'Trade' in thelist and select 'Multiply By'.

6. Inthefield enter '0.8" and click 'OK". Thiswill give a 20%
discount.

Now upload the store and log in to test the discount for 'Trade'
customers. You should see both a'Retail Price' and a'Your Price'
appearing in the store.

More Information - Sophisticated Buyer Options

Go back to the "Test Account' account in Actinic and look at the 'Buyers'
tab. There are quite afew useful options here:

Select 'Hide Retail Prices' if you only ever want thisbuyer to
see asingle price (rather than "Your Price' and 'Retail Price').

Select 'Allow User to Select or Enter aNew Address' if you
want to allow your customersto enter their own new
addressesinto the store, aswell asusing a saved address
online.

You can enter a'Maximum Order Value' for this buyer if you
want to limit the amount they can spend on an order.
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Designing Your Store

Please note that the following features are not availablein 'Client’
versions of Actinic.

Choosing A Theme

A themeisaquick way to give your store anew look and feel. It isworth
experimenting with the themes that are available so you can find oneyou
like - and then useit asa starting point for any further changes.

Exercise - Changing Theme and Colour Scheme

This exercise will just use simple settings to change the look and feel of
your store.

1. Goto'Design| Themes.

2. Inthe'Themes' list, changeit to '‘Corporation'.

3. Inthe'Color' list, select 'The Blues'.

4. Click 'OK".
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Thishas now applied a new look and feel to your store, but you can
change each individual element at a much more granular level.

For exampleyou can tweak the coloursused in the design by going to
'‘Design | Themes' and clicking the 'Advanced Themes Configuration'
button. Then change to the 'Color Schemes' tab.

You can tweak the colours and then save your colours as a new colour
scheme.

More Information - Outer Layouts

When you changethemesin Actinic, aswell as copying in new logo
images and background images, Actinic also changes the 'outer layout'
for the store. The outer layout (also known asthe'overall layout') isabig
piece of HTML codethat controlsthe appearance of the header area of
the design, the sidebars and also the footers. In other words, it lays out
the elements that do not change when you browse from page to page.
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You can seethe outer layout that Actinicis currently using by going to
'Settings| Site Options' and looking at the top of the 'Layout’ panel:

Theimportant one hereisthe'Overall Page Layout' setting, asthat isthe
default onefor your section pages. You'll also notice you can have
different overall layouts for your brochure pages, shopping cart page,
checkout pages etc. if you really want to.
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Adding Custom Fields

Actinic allowsyou to create any number of custom settings for theitems
in your content tree. Examples of thisinclude an 'Artist' field for CDs, a
'Sarring' field for DVDs, or an 'Author’ field for books. These custom
settings arereferred to within Actinic as 'User-Definable Variables', and
they appear within gridslikethis:

You can include these custom valuesinto your store designs by inserting
the variable into the layouts, as discussed in "Help With Design" on page
81.

Exercise - Creating a New Variable

1. Tocreateanew variable, go to 'Design| Library' (or click the
button) and then changeto the 'Variables' tab.

2. Right-click on 'Product’ in the tree and select 'New Variable'.
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In the'Name' field, enter 'Author".

4. Inthe'Description’ field enter 'New field for the author of the
books'.

5. Inthe'Prompt' field enter 'Enter Author Name'.
6. Under 'Place Of Setting' select 'Product'.

This meansthat the new field will appear for your products.

7. De-select 'Allow <Use Parent> as an Option'.
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8. Click 'OK'and the'OK" again to close thelibrary.

You can now changeto the Content tab in Actinic and enter the author
valuein for thethree books. You will find the new field within the
'Properties' panel.

Later on in thisguide, you'll see how to insert these valuesinto the
design.
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Choosing Alternative Layouts

It is possible to select different layouts for every singleitem you seein
the content tree. Thisis done by going to the 'Layout’ panel of theitem in
guestion, and selecting an alternative layout.

Very often a setting will have the words 'Use Parent' in it.

'‘Use Parent' simply means that the value for this setting is set somewhere
‘higher' up the Actinic structure. If you click on a setting it will usually
tell you wherethe value has been set in the area underneath the grid of
settings.

Note: When it saysthevalueis coming from the 'Variable Definition' it
just meansthat the 'Top Level Value' for that variableis set in thelibrary.

Exercise - Changing Layouts

This exercise will show you a selection of changes you can make within
Actinic. To begin with, you will change the way your products appear:

1. Goto'Settings| Site Options' and change to the 'Layout'
panel.

2. Locatethe'Product' heading, and within that, find the
'Product Layout' setting.

3. Changeit to 'Standard With Image On Left'.
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4. Now locatethe'Column Count For Products' setting and
changeit from 'Use Parent (=1)' to '2'.

5. Finally, locatethe'Price Layout' setting and change it to
'Standard Tax Inclusive Price'.

6. Click 'OK"and then look at one of your sections to seethe
change.

Aswell as setting default values for the entire store in 'Site Options', you
can override settings at the section level and at the product level.

1. Inthecontent tree, change to the 'Computers' section.
2. Gotothe'Layout' panel of this section.

3. Click on the'Column Count For Products' field. It says'Use
Parent (=2)' Notice at the bottom of the panel it istelling you
that the value has been set in 'Settings| Site Options'.

4. Changethe'Column Count For Products from 'Use Parent
(=2)'to 1.

5. Changethe'Product Layout' to 'Standard With Image On
Right'.

6. Click 'Apply changes' to see the differencein the preview.

It's possible to change the layout and column count for many different
itemsin the store, such as attributes:

1. Select your 'Running Shoes' product.
2. Select the'Size' attribute (within the 'Option’' component).
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View the attribute's details and changeto the 'Layout' panel.

4. Changethe Attribute Layout' to 'Standard Radio Button
Attribute'.

5. Changethe'Column Count For Radio Buttons' from 'Use
Parent (=1)' to '6".

6. Click 'Apply changes and check the preview. Your radio
buttons should now bein oneline.

More Information - Layout Selectors

The layout selection drop-down listsin Actinic are all controlled by
thingscalled 'Layout Selectors'. It is possible to edit the layout selectorsin
Actinic to change the order of layoutsthat are offered in the drop-down
list, remove layouts and even add your own custom layouts.

Thereis more information on thisin the next chapter - "Inserting
Layouts" on page 88.
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The Design Tab

The 'Design' tab isused to change the look and feel of specific elements of
your page design.

It hastwo main areas:

Interactive Preview - - Click on anything in the
preview and adotted linewill appear around it. If a piece of
text is selected, you will be able to change the appearance of
it with the formatting controlsin the toolbar above the
interactive preview (e.g. bold, italic, colour etc.).

Also,the HTML that lays out the part of the page you have
selected will appear in the 'Layout Code' panel.

Layout Code - - Thisshowsyou the code of
whatever you haveclicked on in the preview. You can edit
the code here and click 'Apply' to see the effect on the
preview.

At the bottom of the Design tab arethree main tabs where you can
change between the Page Preview tab, the Layout Codetab and the
Detailstab (where you can edit names, descriptions, etc.)

You can also click the button to seethe preview and the layout
code at the sametime.

Down theright-hand side of the Design tab is a narrow vertical panel
that either contains the Content Tree or the 'Design Tree' - depending on
what tab is chosen at the bottom of the panel. The Content Tree allows
you to quickly change the section you are viewing in the Design tab. The
Design Tree showsyou all the layouts that make up the current page.
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If you want to select a section to edit, use the Content Tree. If you want to
edit apagethat isn't asection (including email and style sheet layouts)
then usethe 'Select Page Type' drop down at the top left of the Design
tab.

Exercise - Changing Fonts

This exercise will show you how to usethe Design tab to change the
appearance of the text in your store.

1. Gotothe'Homeware' section.
2. Click on the 'Teapot' product namein the preview.

3. Clickonthe iconinthepreview toolbar to makethe
product nameitalicised.

4, Click onthe icon and then choose an alternative colour
for the product names.

You can do thiskind of text formatting for any text in the store.

5. Now click the'Undo' icon on the toolbar -
6. Thisshould reverse out the colour change.

7. Now select adifferent colour.

Notice that the change you made changed all the products on the page -
thisis becausethey are all using the same layout. It will also change the
appearance of productsin other sectionsin your store.

More Information - Working With Dreamweaver

Actiniccomeswith a Dreamweaver extension that allowsyou to supply a
totally custom overall layout to Actinic, and also edit layouts using
Dreamweaver. For more details on this, see the section in the main
Actinic help called 'Working With Dreamw eaver'.
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Help With Design

Designing in Actinic can take alittle whileto understand - thisisjust
because there aren't that many programsthat work in theway Actinic
does. However, once you've learnt the basics, you will discover how
flexible Actinicisto design with.

Theimportant thing isto spend a bit of timetrying to understand how
the various features work, before ploughing ahead and trying to make a
specific change.

These articleswill lead you through the essential things you need to
know.

Using the Preview to Select a Layout

Try clicking within the preview panel in the Design tab.

You should see adotted line appearing round the thing you've clicked
on. Thismeansyou've selected alayout (or an item within alayout).

Layouts are the building blocks of Actinic pages. They are pieces of
HTML that Actinic stickstogether in order to create each pagein the
store.

It ispossibleto seethe HTML code of the layout you've clicked on. To do
this, look at the 'Layout Code' panel. Thiswill either be underneath the
preview, or it will be on a separate tab.

In thetitle bar of the Layout Code panel isthe name of the layout.

Make a mental note of this, asit's useful to know what thelayout is called
in case you ever need to go back to it.

Note: The  button on the layout code toolbar isused to toggle between
an 'advanced' and 'simple' view of the layout code. You generally just
leaveit on the 'simple' view.

Navigating Round the Layouts

Onceyou have selected alayout in the Design tab, look at the layout
breadcrumb trail that runs along the bottom of the Design tab.
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The breadcrumb trail showsyou that the layout you've clicked on is
located within another layout 'above' it, and that layout in turn islocated
within another layout. So in the example above, the product layout is
located within the product list, which in turn islocated within the
'section page' layout - and so on until you reach the 'top' of the design,
which is aspecial layout called the'Overall Layout' (also known asthe
'Outer Layout’).

If you only see onelayout in the breadcrumb trail, it's probably because
you've already got the Overall Layout selected in the preview.

You can click on the layoutsin the breadcrumb trail to select them, and
thisway you can move up in the design.

You can also click the  button on the layout code toolbar and the
icon in the preview to move up alevel in thedesign.

Thedown arrows are for taking you back to the layout you were on
previously.

You can see the full structure of the layouts used to build the page by
viewing the'Design Tree'. To seethetree, click on the tab at the bottom
right of the screen.

Page Structure
All Actinic pages are divided into two parts - the 'outer' and the'inner'.

The'outer' part of the page controls the branding and
navigation elementsthat largely stay the same asyou go
from pageto page. They arethe elementsthat usually go
across the top and down the side of each page. The outer
part of the page also contains the <head> section.
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The'inner' part of the page controls the content for that page
- soif it'sa section pageit will be the section links and
products, and if it's a checkout page it will be the checkout
fields etc.

Outer Layout

The outer part of the pageis controlled by alayout called the 'Overall
Layout' (also known asthe 'Outer Layout'). Thisisthe 'top' layout of each
page - which every other layout isinserted within.

Outer layouts always contain apink/ purple placeholder called
INNERLAYOUT, which will bereplaced by the content (inner layout)
for that page when the page is generated.

You can select the overall layout within the Design tab by clicking
anyw here within the preview, and then clicking thefirst layout on the
layout breadcrumb trail.

Alternatively, you can view the Design Tree and then click on thetop
item in thetreeto select the overall layout.

All the outer layouts are kept together in the library within agroup
called 'Web Page Outer Layout'.

You'll find out more about thelibrary in amoment.
Inner Layout

Theinner layout is harder to talk about asit will be different depending
on which page you are looking at.

For section pages, the inner layout will probably have a namethat starts
within 'Section Page...' and when you look in the code of it, you'll see lots
of references to 'section lists' and 'product lists'.
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Every 'type of page has adifferent inner layout that controls the layout
of its content. All theinner layouts used by the store are collected
together in thelibrary in agroup called 'Web Page Inner Layout'.

Editing and Undoing

You can make a change to the HTML of alayout and then click the
'‘Apply' button to see what effect this has on the store.

The preview will be automatically updated when you click 'Apply'.

If you are not happy with theresults, click the 'Undo’ button on the
toolbar to undo the change -

You can also edit layouts using Dreamweaver. Thisis described in the
main help in asection called 'Working With Dreamweaver'.

Remember when making changes that thislayout is probably going to be
inserted within another layout, so be careful when making changes that
you don't do anything that might distort or corrupt this'parent’ layout.

If you have made a mistake with alayout, and you cannot work out how
to get the layout working again then you can always revert the layout
back to its 'factory settings'. Thisisdescribed in the next section.

The Library

The Design tab allowsyou to edit the layouts that are used within a page,
but the Library allowsyou to search through and edit all the layouts
within Actinic.

You can open thelibrary by going to 'Design | Library', then changeto
the 'Layouts' tab.

Highlighting the layouts you've edited
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If you click the'Highlight edited library layouts (*)' checkbox at the
bottom of the 'Layouts' tab, you will highlight any layoutsyou've
customised, and new layoutsyou've created.

Layoutsyou've customised will be marked with a(*) and havea  icon.

You can also highlight any new layoutsyou've added by selecting the
'‘Highlight new user layouts (+)' checkbox.

Searching for layouts

Right-click anywhere within the Layouts tab and select 'Find'.

You can search for the name of alayout or some code within alayout.
Creating new layouts

Right-click on alayout and select 'New Layout'.

Givethe layout aname and click 'OK".

Note: You can also create new layouts within the Layoutstab of a
product/ section/ Site Options. Smply select the '<New>' option at the
bottom of the drop down lists.

Deleting layouts

You can only delete alayout from thelibrary if it's a custom layout that
you've created, and you haven't selected it anywhere.

Reverting to Factory Settings

If you have made a mistake in alayout, and you want to put it back to
how it was before you started making changes to it, then you can right-
click onitinthelibrary and select 'Revert to Factory Settings'.
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Layout selectors

Layoutsare only part of the picture. There are also round things called

‘Layout Selectors' -  -that control how layouts arelisted within the
‘Layout’ panels.

You can edit these layout selectorsto change which layouts are listed
within Actinic, and in what order.

Inserting Variables

Variables are placeholders for Actinic data. When the pages are
generated, thevariables are replaced by real data.

Variablesin layoutslook like this:

Inserting anew variableissimple. Let's say you wanted to add a new
link to your home page. To do this, you might add the following HTML
into the layouts:

You can now place your cursor between the two quote marks and click
the'Insert Variable' button -
Thelist of layoutsisinitially really long, but you can usethe'List names

containing' filter the search. If you enter 'Home' into thelist, thelist
becomes:
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You can now highlight 'HomePageURL' and click 'Insert'.

Exercise - Including the 'Author' Variable into
the Design

Earlier on in thisguide, you created anew 'Author’ variable. This
exercise will show you how toincludeit in the design.

1. GototheDesign tab and then make sureyou are looking at
the 'Books' section.

2. Click on the name of one of the books on this page. This
should highlight the 'ProductName' variable.

Add in anew blank line straight after the variable.

4. Inthenew blank line, type<br />

You might notice that Actinic promptsyou hereto complete the tag. This
isafeatureof Actinic- it will help you create the HTML within the
layouts.

5. lust after the<br /> right-click and select 'Insert Variable'.
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6. Select 'Author' from thelist of variablesthat appears and
click 'Insert’.

7. Click 'Apply' and check the preview to seeif your value have
appeared.

If the author value has not appeared for all your books, it may be because
your books are using different layouts from each other. You may need to
insert the<br />Aut hor in morethan one layout.

Inserting Layouts

Toinsert alayout, usethe  button on thelayout codetoolbar.

What you get presented with though isnot alist of layouts - rather, you
get alist of Layout Selectors (which you might have seen within the
Library).

The job of alayout selector isto insert atype of layout into the design.
You can see these layout typesin the 'Layouts' tab of thelibrary.

For example, inserting the 'ProductLayout’ layout selector will insert a
product layout into the design, and the'AddToCartButton' layout
selector will insert an add to cart button into the design. The actual
layout that isused is controlled elsewhere - usually in Site Options.
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If thereis aspecific layout that you know you want to insert, rather than
just inserting any layout of a particular type, then you can select the 'Use
Fixed Layout' button and select one from thelist.

Warning - using 'Fixed Layouts means that you will no longer be able to
change thelayout in Site Options or in the Layout panel of your
sections/ products. More detailsarein "Advanced: Fixed Layoutsvs.
Selectable Layouts" on page 90.

Hiding Things With Conditions

When you look in layouts, you see lots of green 'block if' tags.

These are conditions, which will hide the text between the block tags
unless a certain condition ismet. You can view and edit the condition by
double-clicking on the opening 'block if' tag.

In the above example, the text shown is hidden unless the 'Author’ field
hasavalue. If the'Author' setting doesn't have avalue, then the whole
thing is hidden.

Using Stylesheets

Actinic makes use of stylesheetsto control layout and fontsin the store. If
you want to change the layout of items on a page, or the default
appearance of text, you will probably have to think about editing the
main Actinic stylesheet.

Note: You can edit the default font size and appearancein the 'General’
panel of 'Site Options', and you can edit coloursin the 'Color Schemes'
tab of 'Design | Themes'.

Whenever you see a style used in Actinic layout e.g.:

... you can right-click on the style and select 'Look Up In Stylesheet'.
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You can then edit the style asrequired.

The layout that controlsthe stylesheet is called 'Actinic Stylesheet'. You
can also select it from the 'Select Page Type' drop down list in the
'Design' tab.

Note: In the Library, you'll find the'Actinic Stylesheet' layout within the
'‘Web Page Outer Layout' group.

You can useyour own styleswith Actinic. Either just add them to the
bottom of the 'Actinic Stylesheet' layout, or save your stylesheet within
the Actinic site folder and then use atag similar to the following to add
link your stylesheet in.

Thistag needsto go in the <head> section in the overall layout used by
the site.

If you right-click on an HTML tag in your layout that isusing atag from
your custom stylesheet, and then select 'Look Up In Stylesheet’, Actinic
will open up your custom cssfilein your default CSS editor.

Advanced: Fixed Layouts vs. Selectable Layouts

In the section called "Inserting Layouts" on page 88it talks about how
when you insert alayout selector, you have a choice.

You can insert alayout selector into the design, without
specifying a specific layout - thisis also known asusing a
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Layout Placeholder

Alternatively, you can select a specific layout to insert into
the design - thisis known as a Fixed Layout

Using Layout Placeholders

When you insert alayout placeholder (rather than afixed layout) it will
insert atype of layout into the design. You can generally choose the
layout to be inserted within the 'Layout' panel of 'Settings| Site Options.

You can then often override this setting within the Layout panel of a
section, or of aproduct.

Not all layout selectors have a place of setting in Site Options. If you find
onethat doesn't, then you need to go to the 'Layouts' tab of 'Design |
Library', and edit the layout selector there.

Edit the 'Top Level Value' therein order to change the layout that will be
inserted.

Fixed Layouts

When you insert afixed layout, it effectively disables the layout selection
optionsin 'Settings| Site Options'. The choice of layoutsis still there, but
they will beignored when the pages are built.

To change afixed layout into alayout placeholder, you can right-click on
the pink layout namein layout code and select 'Edit Appearance'.

In the screen that appears, set the'Use Fixed Layout' option to 'No()' and
click 'OK".

Advanced: Editing Lists

Aswell as standard layouts, you will sometimes come across things
called lists. They look like thisin the layout breadcrumb trail:

Lists always have an orange link across thetop of the layout codethat
says 'Click hereto edit list layout settings":

Listswork differently to other layouts. Their job isto insert a set of items
into a page. Wherever you see alist of products, or alist of sub-sections,
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or alist of best sellers, or alist of locations, somewherein there alist will
be controlling the placement of theitems.

Editing thelist allowsyou to edit the HTML that goes at the start of alist
of items, at the end of alist of items and around each individual item.

To edit alist, click the orange 'Click hereto edit list layout settings' text at
the top of thelayout, or click the 'Edit List Layout Settings' button.

The 'Start of List' and 'End of List' fields here are self explanatory. It gets
abit trickier in the 'Edit Rows/ Columns' tab:

Don't panic! This screen looks more complicated than it is. Thisiswhere
you can control the code that goes before and after each item in thelist.
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Generally, you only haveto worry about the'Middle Rows'. Only usethe
'First Row' and 'Last Row' settingsif you want thefirst or last row to be
different to the other rows. The'No of items' iswhere you can set the
number of columnsin your list - but thisonly worksif your list isatable.
Otherwise, just leave this set to 'Dynamic'. If you see avariable within
thisfield, it meansyou can set the number of columnsin the'Layout' tab
of the section/ product you are currently editing.

Also, there are three sets of 'Before' and 'After' fieldsjust in case you have
multiple columnsin your list and you want the columnsto look different
from each other. Most of thetimeyou can just put the same code into
each set of fields.
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